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Important Safety and Warranty InformationImportant Safety and Warranty Information

We value you as a customer—and want our products to give you an inspiring, and gratifying, 
experience. So, to insure your safety and protect your investment in Gibson’s Firebird X 
guitar, please read and follow all safety warnings and operating instructions before using 
this product, and keep all documentation for future reference.

Environmental FactorsEnvironmental Factors

Heat and moisture can harm your Gibson Firebird X. Please do not install or operate this 
guitar near sources of moisture, such as sinks, damp basements, leaky roofs, etc. and never 
store it near heat sources, such as heaters or radiators. Both you and your Firebird X will be 
much happier if you store and operate this product under safe conditions.

Power SourcesPower Sources

Use only the power sources included in the Firebird X package. Make sure any power supply 
cords are not located where they are likely to be safety hazards, such as on the floor where 
people might walk, or in locations where they may receive pressure from items placed upon 
or against them. Also, be very careful with any power source connections, such as where 
the AC adapter connects to the wall outlet. If this is jostled loose, the G-Node USB 2.0 
audio interface included with Firebird X may experience extreme power differentials, 
which can potentially harm you and the product.

ServiceService

Please do not attempt to service Firebird X or any of its accessories yourself—let our expert 
technicians handle any repairs for you.

Speaking of experts, always send the Firebird X or G-Node USB 2.0 audio 
interface to the factory for servicing if any of the following occurs:

✗ Any foreign object (especially liquid) has gotten inside Firebird X or its accessories
✗ Firebird X or its accessories have been exposed to water, dropped, or otherwise 

damaged
✗ A marked change in Firebird X’s performance
✗ You hear anything rattling around inside if you shake the Firebird X gently
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Warranty ProtectionWarranty Protection

It is extremely important to us that you are satisfied with Firebird X. Register it and 
activate your warranty protection by mailing the warranty card included with Firebird X to 
Gibson USA, Department W, P.O. Box 100087, Nashville, TN 37210-0087. If you encounter 
any kind of problem, contact us as soon as possible so we can make things right.

Once you your warranty protection is active, Firebird X's electronic components are 
warranted to be free from defects in materials and workmanship for a period of one (1) 
year from the date of original purchase. Your warranty covers the cost of both labor and 
materials on any repair deemed necessary by our Customer Service Representative for the 
warranty period, subject to the limitations below. Please note that our warranty belongs to 
the original retail purchaser only, and may not be transferred or assigned to subsequent 
owners.

If Firebird X malfunctions as a result of faulty materials or workmanship, Gibson will 
determine whether repair or replacement is more appropriate. In case the original 
materials are no longer available for repair, Gibson reserves the right to use materials 
regularly utilized at the time of repair.

If we determine that replacing Firebird X best serves your interests, or in the unlikely event 
that it is destroyed, lost, or damaged beyond repair while in our possession for repairs, we 
will replace the product. If it is no longer available, it will be replaced with the most 
similar product whose value does not exceed your original product’s purchase price.

Remember—as a necessary condition to the warranty coverage described in this section, you 
must activate your warranty by mailing the warranty card included with Firebird X to 
Gibson USA, Department W, P.O. Box 100087, Nashville, TN 37210-0087.

Warranty LimitationsWarranty Limitations

Unfortunately, your product warranty cannot cover :

✗ Any product that has been altered or modified in any way, or upon which any serial 
or registration number has been tampered with or altered in any way.

✗ Any product whose warranty card has been altered or contains false information.
✗ Any product that has been damaged due to misuse, negligence, accident or improper 

operation or storage.
✗ Any product damaged during shipment. Inspect the package immediately upon 

receipt, and notify the carrier immediately if there is damage.
✗ Any product damaged as a result of extreme temperature, humidity, or the use of an 

improper power source.
✗ Any product not purchased through an authorized dealer, or any product that has had 
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repairs, modifications or alterations made by an unauthorized service technician.
✗ Wear and tear based on normal usage.
✗ Factory installed electronics after more than one year following the original date of 

purchase.

Gibson makes no other express warranty of any kind. All implied warranties, including 
warranties of merchantability and fitness for a particular purpose that exceed the specific 
provisions of the warranty, are expressly and specifically disclaimed and excluded from the 
warranty. Note, however, that some states and/or countries do not allow the exclusion or 
limitation of implied warranties, so this paragraph may not apply to you. In particular, if 
you purchased your product outside of the United States, contact your local distributor for 
the handling and resolution of all warranty issues, as the warranty described here is not 
always applicable.

And of course, Gibson shall not be liable for any special, indirect, consequential, incidental 
or other similar damages to you or to any third party, including, without limitation, 
damages for loss of profits or business, or damages resulting from use or performance of 
the product, whether in contract or tort, even if Gibson or its authorized representative has 
been advised of the possibility of such damages, and Gibson shall not be liable for any 
expenses, claims or suits arising from or relating to any of the foregoing.

To obtain warranty service, please contact Gibson directly:

US (Toll Free)     1-800-4GIBSON
US (Local)          1-615-871-4500
Email - service@gibson.com

Never send a unit in for repair before contacting Gibson. You will be advised of the proper 
procedure for a quick and efficient repair, as well as provide information on where and how 
to send your Firebird X.

Gibson® is a trademark of the Gibson Guitar Corp.
Windows® and Windows 7® are registered trademarks of Microsoft, Inc.
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Chapter 1: IntroductionChapter 1: Introduction

The FBX Editor for Mac and Windows provides an environment for programming virtually all 
aspects of the Firebird X’s operation. You can:

✗ Edit existing presets
✗ Create new presets using a wide variety of effects
✗ Save an unlimited number of presets to a Library
✗ Transfer presets from the Library into Firebird X to create custom collections of 

guitar patches
✗ Create custom tunings and assign tunings to patches
✗ Customize the Digital Varitone tone knob response
✗ Customize the Volume knob response. 
✗ Play back licks so you can tweak effects without having to use your hands to play 

guitar

...and much more. 

Minimum System RequirementsMinimum System Requirements

FBX Editor requires a desktop or laptop computer with:

✗ Installed and working G-NodeTM interface. Please see the G-Node manual for 
information on installing and using the G-Node.

✗ At least 1GB RAM (more RAM is highly recommended for audio applications) 
✗ Mac: Mac OS X Snow Leopard 10.6.4 or higher (including Lion).
✗ Windows: Windows 7, 32- or 64-bit version. Other Windows versions may work, but 

Gibson cannot provide support for them.

STOP!STOP! Read the G-Node Read the G-NodeTMTM Manual First Manual First

This manual assumes you have downloaded the FBX Editor, installed the software necessary 
to run the G-Node interface, have a working G-Node interface, and have updated all your 
system software to the latest version. If you have not done these steps yet, please refer to 
the G-Node manual and follow the instructions for how to do this.
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SetupSetup

1. Make sure the G-Node is connected to your computer and functioning.
2. Connect the supplied TRS audio cable from your Firebird X to the G-Node guitar input. 
Do not use standard cables as they do not allow for proper data transfer.
3. Turn on Firebird X by pulling up on the Gear Shift knob.
4. Open the FBX Editor program.
5. The program will check the G-Node and Firebird X firmware. If new firmware is 
available, you will be asked if you want to update. Gibson strongly recommends updating; 
see the G-Node manual for information on updating your system.
6. If your firmware is up to date, FBX Editor will open and a window will appear that lets 
you select a preset for editing. Double-click on a preset to load it into FBX Editor (or click 
on it to highlight it, then click on OK). If you don’t know which preset you want to edit, 
click on Cancel.

Important! If FBX Editor can’t read the firmware version, hangs on the firmware check  
screen, or won’t open, there may be a G-Node connection issue. With Firebird X still  
turned on, close the dialog box and let the Editor open. Then unplug the TRS cable from  
Firebird X, wait a few seconds, and plug it back in. This resolves most connectivity issues.

The FBX Editor DashboardThe FBX Editor Dashboard

The Dashboard is toward the left of the FBX Editor, and is always visible regardless of what 
tab or function is selected. It’s outlined in red in the screen shot below.
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G-Node Active: Blinks green to indicate the G-Node is communicating with Firebird X.
G-Node Online: The G-Node is connected to your computer and communicating via USB 2.0.
Firebird X: This indicator alternates between Offline and Connecting if Firebird X is 
unplugged. Once connection is complete, the indicator lights green, stays lit, and says 
Ready.
Wah Pedal (Pedalboard): If this is on and linked via Bluetooth, the Online indicator will be 
lit green.
Switch Pedal (Switchboard): If this is on and linked via Bluetooth, the Online indicator will 
be lit green.

Change FBX Editor SizeChange FBX Editor Size

You can change the amount of space the FBX Editor takes up on screen to accommodate 
lower- or higher-resolution monitors. 

✗ For lower-resolution monitors (up to approximately 1280 x 1024 pixels): Go View 
> uncheck Large Fonts.

✗ For higher-resolution monitors: Go View > check Large Fonts. 

If you change from one font size to another, you will need to close and re-open FBX Editor 
for these changes to take place.
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Chapter 2: Loading, Saving, and Managing PresetsChapter 2: Loading, Saving, and Managing Presets

As soon as you open FBX Editor, a window opens to let you load a preset from the guitar for 
editing. If you cancel the loading process, you will need to click on any other tab (Library, 
Tuner, Tone Knob, etc.) and then click on Edit Preset again to select a preset to edit.

Once you’ve edited a preset as described in Chapter 7 of this manual, you have three 
options. After doing any of these, the preset selection window will open.

✗ Go File > Save to Disk. This saves the edited Preset to your Preset library (with 
Windows 7, located at C:\Users\[user name]\Firebird X\Presets; with the Mac, at 
Home\Firebird X\Presets). You can create other folders for presets, and navigate to 
them if desired. Individual files have a .FBX suffix.

✗ Go File > Save to Guitar. This overwrites the file you loaded from the guitar with 
the edited version. Note: This will always overwrite its original location, regardless  
of what preset is selected on the guitar. For example, if Firebird X’s Gear Shift is  
set to Bank 1 and the Preset Selector to position 2, you open a patch from Bank 4,  
Position 3, edit it, and save it to guitar, it will save to Bank 4, Position 3.

✗ Go File > Cancel Edit. This discards any edits you made without saving them.

Backup and Restore GuitarBackup and Restore Guitar

✗ Backup Firebird X’s entire contents. Go File > Backup Guitar. You can create 
multiple backups with, for example, presets for different musical styles. Backing up 
can take up to two minutes as all presets have to be read, saved, verified, and 
combined into a single file. These files have the suffix .GBAK to indicate they are 
backup files. 

✗ Restore a backup. Go File > Restore Guitar and choose the desired .GBAK file to 
restore. After restoring, refresh the listing of names by clicking on a tab other than 
the currently selected one. For example, if you do a restore operation with the 
Library tab selected, click on the Tuner tab and when you click on the Library tab, 
the software will read the restored names in the guitar.

Full Guitar ResetFull Guitar Reset

This restores all aspects of the guitar—presets, tunings, tone knob, volume knob, everything
—to the original factory settings. This can be done from the Red Bank (as described in the 
last part of Chapter 5 in the full Guitar manual) or from the Editor.

Caution! Make sure you’ve backed up any presets you don’t want to lose before resetting  
Firebird X.
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To reset:

1. Click on the Edit Preset tab to select the main editor screen.
2. Click on a blank spot in the main editor screen to make sure it has the focus.
3. Type Alt-Shift-R (Windows), Option-Shift-R (Mac). A warning screen will appear to confirm 
that you truly want to restore Firebird X to all factory defaults.
4. To restore, click Yes. Otherwise, click No to exist this function.

Preset Management in the LibraryPreset Management in the Library

The Library tab shows the presets currently in Firebird X toward the left, and a Browser 
window to the right.

The Browser has buttons to select the Firebird X Library, your Documents, or the Desktop. 
An additional Browse button opens up a traditional browser so you can browse anywhere on 
your computer or on any external drives (including USB memory sticks, hard drives, a 
network, etc.).
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Drag Presets into Firebird XDrag Presets into Firebird X

You can drag any preset from any of these locations, as well as from any location in your 
computer (the desktop, a folder on the desktop, an external hard drive, etc.) into a 
Firebird X preset location. For example, you could drag a preset from the Library window 
into Bank 1, Switch Position 3 in the left window; selecting that preset with the Gear Shift 
and Preset Selector will now load the preset you transferred over from the Library.

Drag Presets out of Firebird XDrag Presets out of Firebird X

You can also drag a preset from Firebird X into the Browser window on the right, regardless 
of whether it shows the Library or some other location in your computer (e.g., Documents, 
Desktop, or someplace chosen with the Browse button). However, you cannot drag a preset 
from Firebird X to the desktop. A preset must be dragged into the Browser window.

Presets dragged from the guitar are identified only by a number, so you will likely want to 
rename them (see next).

Rename Banks and PresetsRename Banks and Presets

To rename Firebird X Banks or Presets, or the names of any presets that appear in the 
Browser window, right-click (Mac: Command-click) on the name, select Rename, then enter 
a new name in the pop-up window. Preset names are limited to 14 characters.

Delete PresetsDelete Presets

To delete presets from the Browser window, drag them to the trash can icon in the lower 
right. As a safety measure to prevent accidental erasures, you can’t delete any other kind 
of file, nor can you delete presets stored within Firebird X directly.
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Chapter 3: Tuner TabChapter 3: Tuner Tab

The tuner tab lets you:

✗ Associate a particular tuning with a preset
✗ Create new alternate tunings
✗ Save tunings to disk
✗ Replace the stock Firebird X tunings with custom tunings, or re-assign their order

There are four main workspaces in the Tuner page.

✗ The Preset Assigned Tuning list (upper left) shows the presets in Firebird X, and the 
tuning associated with each preset. 

✗ The Guitar Tunings list (upper right) shows the presets stored in Firebird X. These are 
the tunings you access by moving the Silver tog-pot to the down position, then 
selecting a tuning with the Gear Shift knob.

✗ The Saved Tunings list (lower right) shows tunings saved to disk.
✗ The Current Tuning section (lower left) lets you name and save custom tunings. 
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Tuning Assignment BasicsTuning Assignment Basics

The stock, out-of-the-box FBX has no tunings associated with presets. If you flip the Silver 
togpot down to the Tuning position, the guitar will tune to standard tuning. However, this 
changes once you start assigning tunings.

When a preset does not have an associated tuning, you’ll see “--none--” as the associated 
tuning in the Tuner page’s Preset Assigned Tuning list. You can assign a tuning to a preset 
either in the main Edit Preset page or the Tuner page, as described in the next section.

However, note that “--none--” is not the same as standard tuning. It simply means the 
preset will use whatever tuning is the current tuning. If you need a preset to always use 
standard tuning, then you need to assign Standard tuning to that preset.

For example, suppose preset 4-2 has “--none--” as the assigned tuning, preset 3-1 has 
"Dropped D" assigned, and the current tuning is standard. If you select preset 4-2 and 
initiate tuning, it will tune to the current tuning (standard) because no particular tuning 
has been assigned to 4-2. If you now select preset 3-1 and initiate tuning, it will tune to 
Dropped D because that is its assigned tuning. So, Dropped D becomes the current tuning.

If you select preset 4-2 again and initiate tuning, it will tune to Dropped D because that is 
the current tuning—preset 4-2 has no assigned tuning. If preset 4-2 had Standard as the 
assigned tuning instead of “--none--,” then selecting preset 4-2 and initiating tuning would 
tune to Standard tuning.

The reason for this behavior is that you may have presets that you want to be able to adapt 
to whatever tuning you’ve selected. For example, suppose you select a preset with Dropped 
D tuning assigned, but now want to change the sound. If that sound has “--none--” 
selected, and you need to re-tune, it will re-tune to Dropped D.

There are two main ways guitar players use tunings with Firebird X.

Option 1: Assign all presets to “--none--,” and choose the desired tuning as needed by 
flipping the Silver togpot down and selecting the tuning with the Gear Shift knob. This 
tuning will remain until changed.

Option 2: Assign tunings to all presets, generally using Standard as the default but choosing 
other tuning assignments as needed.

Associate a Tuning with a PresetAssociate a Tuning with a Preset

In the Tuner page (click on Tuner tab), drag a tuning from the Guitar Tunings list to the 
desired Preset’s Tuning column in the Preset Assigned Tuning list. This setting will persist if  
you change presets. 
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You can also assign a tuning from the main edit page (click on Edit Preset tab) by clicking on 
the Assigned Tuning pop-up menu and selecting a tuning. This is a temporary setting that 
will not persist if you call up a new preset. If you selected a tuning in the Tuner page that’s 
different from the tuning on the Edit Preset page, the tuning in the Tuner page takes 
priority if you re-load the preset. 

To "unassign" a tuning, on the Tuner page drag "--none--" from the Guitar Tunings list to the 
associated preset in the Preset Assigned Tuning list. You can also choose “--none--” from the 
Assigned Tuning pop-up menu on the Edit Preset page, but as with any other tuning selected 
in this manner, this setting will not persist if you change presets.

When you call up a Firebird X preset with an assigned tuning, Firebird X does not tune 
automatically. You need to push the Silver togpot down, then strum to tune to the assigned 
tuning (it is not necessary to select a tuning with the Gear Shift knob first).

This tuning will remain until you re-tune the guitar, either by selecting a tuning, or 
selecting a preset with an assigned tuning and initiating tuning.

Create a New TuningCreate a New Tuning

There are two views, Basic and Advanced.

1. With Basic tuning, click on the string “tuner” and choose a note from the pop-up menu 
from the list of allowable notes. 
2. Repeat as desired with each string to create the custom tuning.
3. When done, name the tuning in the Current Tuning section. You can also choose what will 
be displayed in the Gear Shift knob when you call up this tuning.
4. To save this tuning to disk, drag the tuning head icon from the Current Tuning section to 
the Saved Tunings list.
5. To save this tuning to Firebird X, drag the tuning head icon from the Current Tuning 
section to one of the slots in the Guitar Tunings list. This will replace whatever tuning is 
already in the guitar at that slot.

For the Advanced option, check Advanced View.
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Now when you click on a string “tuner,” you see a visual representation of the range of 
possible notes, as well as a slider that lets you “stretch” string tunings in one-cent 
increments. For example, in the tuning shown in the screen shot, the D string has been 
tuned up to E and the G string has been tuned down to E, but the G string is tuned 4 cents 
sharper than E to produce a chorusing effect when played at the same time as the “D” 
string.

Delete a TuningDelete a Tuning

You can delete only tunings that are saved to disk. Drag the tuning from the Saved Tunings 
list to the trash can icon located toward the bottom left of the list.

Transfer TuningsTransfer Tunings

You can drag a tuning from the Guitar Tunings list to the Saved Tunings list, and vice-versa.
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Chapter 4: Digital Varitone Tone Knob TabChapter 4: Digital Varitone Tone Knob Tab

The Digital Varitone Tone knob quantizes the tone knob into 10 zones, each of which can 
have its own frequency response and level (as determined by a six band parametric EQ). 
You can create subtle changes among zones to “morph” through tones as you change the 
tone knob, emulate the response of a standard tone control, or “switch” among different 
responses. For example, to make it easy to find a particular tone, you could create the 
same response for zones 0 and 1, 2 and 3, 4 and 5, 6 and 7, and 8 and 9 to create five 
different, easily-selectable responses instead of 10. 

Each zone can also have its own gain, so you could have a standard tone control response 
from zones 0 through 8, but then if you turn the knob to position 9, have a frequency and 
volume boost for something like playing leads.

Whatever response you create on this page will be transferred to Firebird X in real time, so 
it’s easy to try out different responses. Note that sometimes creating a notch response can 
be as useful, if not more so, than a boost.

Create a Digital Varitone PresetCreate a Digital Varitone Preset
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1. Move the 10-position knob on the left to the zone you want to edit.
2. Edit the response with the six-band parameter EQ.
3. Balance the levels among zones with the EQ input and output controls.

Manage Digital Varitone PresetsManage Digital Varitone Presets

Save a preset: Click on the + sign in the lower right. Enter a name, then click on OK.
Load a preset: Click on the rectangle to the left of the + sign, and choose a response from 
the pop-up menu.
Delete a preset: Open the preset you want to delete, then click on the – sign. 
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Chapter 5: Volume Knob TabChapter 5: Volume Knob Tab

Like the Digital Varitone, the Volume knob is quantized into ten zones; each can have its 
own level setting. This lets you emulate any type of volume control taper, including custom 
tapers for players who like to use their pinky to create “swells” at the beginning of notes. 
Note: Set Zone 0 to –144.00 dB if you want to be able to shut off the sound entirely.

There are three ways to create a taper.

✗ Select a zone with the left knob, then set its level with the fader.
✗ Click on a node in the graph, and drag to the desired level.
✗ Click on a node in the graph, and set its level with the fader.

Manage Volume Knob PresetsManage Volume Knob Presets

Save a preset: Click on the + sign in the lower right. Enter a name, then click on OK.
Load a preset: Click on the rectangle to the left of the + sign, and choose a taper from the 
pop-up menu.
Delete a preset: Open the preset you want to delete, then click on the – sign. 
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Chapter 6: Licks TabChapter 6: Licks Tab

The Licks tab lets you choose one of 37 factory licks, as well as record your own licks, that 
you can then play through the effects as you edit them. This can be extremely helpful when 
you want to tweak a sound, but don’t want to play the same riff over and over again. Once 
you play a lick, it will loop until stopped. 

Note for Macintosh users: The Mac may not automatically select the G-Node as the output 
audio device, in which case you need to select it with the Audio MIDI Setup applet 
(otherwise, Lick Play won’t function). To do this, go Apple Menu > System Preferences >  
Sound > Output tab. Select Gibson G-Node as the output device. 

Select and Play a LickSelect and Play a Lick

1. Click on the lick name or number, then click on the Play button.
2. Click on the Edit Preset tab, and either cancel to use the existing preset, or select a 
preset to edit.
3. Edit the preset while the lick plays.
4. You can also play and stop the lick with the transport buttons toward the lower right of 
the Edit Preset window.
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Record a LickRecord a Lick

1. Click on the record button and start playing. Recording begins as soon as you click on 
record.
2. Click on stop when you’ve recorded your lick.
3. Name the lick.
4. Your new lick will be at the bottom of the list.

Delete a LickDelete a Lick

1. Click on the lick name or number.
2. Click on the trash can icon.
3. A window appears that gives you the option to remove the clip. Click on Yes.
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Chapter 7: Edit Preset TabChapter 7: Edit Preset Tab

Here is where you can modify existing sounds, or create entirely new ones. The effects are 
laid out very much like a pedalboard. This presents an overview; for details on the 
effects and sound design in general, please see Chapter 9.

General Editing GuidelinesGeneral Editing Guidelines

There are two types of processors, single effects (parametric EQ, Octaver, Wah, 31-band 
graphic EQ) and effects blocks with multiple processors (for example, the Tube Effects 
block includes Noise Gate, Compressor, Distortion, and Cabinet effects).

✗ To open a single effect for editing, click on the effect name.
✗ To open an effects block for editing, click anywhere on the block. This reveals single 

effects that you open by clicking on the effect name.
✗ To bypass a single effect or tone block, click on the square bypass/enable button in 

the effect or effect block’s lower left (red is enabled). If the effect has a 
“footswitch,” you can click on that as well.

✗ If a block’s effect has a visible knob, it is adjustable.
✗ There are two ways to change a knob setting: Click on it, and move your mouse in a 

circular motion to “turn” the knob; or click on it, and a “big slider” appears toward 
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the left. Move this slider up or down to change the knob setting.
✗ When you open an effect or effects block, you can close its by clicking on the X 

button in the upper right. Click on the blue button in the upper left to “float” the 
window, allowing you to move it outside the editor screen. This is very useful for 
dual monitor setups, as you can have the main FBX Editor in one window, and move 
the effects to the other monitor. 

Edit Pickup Wiring ConfigurationEdit Pickup Wiring Configuration

Right-click on a pickup, then choose the desired configuration.

Effects Signal PathEffects Signal Path

The effects are arranged in the following signal path:

Tone Block

✗ Separate nine-band parametric EQs for the piezo and magnetic pickups
✗ Piezo blend control for adding in piezo sound
✗ PreFilter that affects low-frequency response

Tube Effects Block

✗ Noise Gate
✗ Compressor
✗ Distortion
✗ Cabinet Emulator

Six-Band Parametric EQ Single Effect, Octave Divider Single Effect, Wah Single Effect 
(Wah is located between the Tremolo and Delay 1 in the Tape Effects block)

Tape Effects Block

✗ Phaser
✗ Chorus/Flanger/Vibrato/Automatic Double Tracking/Resonator
✗ Tremolo
✗ Delay 1 (Standard Delay, Ducking Delay, Chorus/Delay, Reverse Delay)
✗ Delay 2 (Standard Delay, Ducking Delay, Chorus/Delay)
✗ Reverb

31-Band Output Graphic EQ
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Chapter 8: UtilitiesChapter 8: Utilities

MeteringMetering

The Edit Preset section has extensive metering to make it easy to avoid distortion in the 
effects signal path, as well as match levels at the output.

The two meters in the lower middle display RMS levels, and have two different states.

If an effect is not selected for editing, the left meter shows the level at the Tone Block 
output (e.g., the mixed sound of all selected pickups). 

When you select an effect for editing, these meters display the input level coming into the 
effect from a previous effect, and the output from the selected effect. For example, if 
you’re editing the Post-Distortion EQ, the left meter shows the input signal coming from the 
Cabinet output, while the right meter shows the Post-Distortion EQ output level.

The two horizontal white bars in the meter indicate the average RMS level over time.

Clicking on these meters brings up eight-band meters that show the levels in various bands 
of the audio spectrum. 
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Large MetersLarge Meters

You can also show/hide large, high-resolution meters to the right of the main Editor 
window. To toggle between showing or hiding them, go View > View Meters or type Ctrl-P 
(Mac: Command-P).

The left meter always shows the level at the Tone Block output (e.g., the mixed sound of 
all selected pickups), while the right meter always shows the final FBX output.

The output meter is very helpful in matching patch levels, with the pop-up menu below the 
meters offering three different meter responses (Peak, Loudness, and RMS). For matching 
levels, RMS gives a mathematical average, while Loudness takes into account some psycho-
acoustic aspects. Most patches reach a nominal -27dB RMS at full volume, but of course, 
this varies depending on the effects that are used, whether the part is intended for rhythm 
or lead, and the like.

The two horizontal white bars in the RMS meter indicate the average RMS level over time.
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Saved SettingsSaved Settings

Each effect has a “Saved Settings” option that allows saving a particular patch for that 
individual effect. For example, if you come up with a distortion sound you really like, you 
can save just that distortion sound and use it in other patches.

Save an Effect Setting Save an Effect Setting 

1. Click on the + sign in the effect’s lower right.

2. Enter a preset name in the window that appears, then click on OK (or Cancel if you 
decide you don’t want to save it after all).

Load an Effect Setting Load an Effect Setting 

1. Click on the Saved Settings button (if you previously selected a Saved Setting, this button 
will show its name).
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2. Select the Saved Setting from the pop-up menu in one of two ways: Click on its name, or 
use your keyboard’s up/down arrow keys to select the desired setting, then hit Return or 
Enter on your keyboard.

Delete an Effect Setting Delete an Effect Setting 

1. From the pop-up menu, select the Saved Setting you want to delete. 
2. Click on the – button in the lower right.
3. When the confirm preset delete window appears, click on OK (or Cancel if you don’t 
want to delete it after all).

There’s an additional “safety” option to avoid accidental erasures. After you delete the 
effect setting, it will still be loaded into the effect. If you change your mind about deleting 
it, click on the + sign before selecting another preset, and you can save the “deleted” 
preset.
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Exporting and Importing SubPresetsExporting and Importing SubPresets

The complete collection of Saved Settings is called a set of SubPresets. To save all of your 
saved settings as a single SubPresets file:

1. Go File > Export SubPresets.
2. The Editor navigates automatically to the Bin folder (located in the main Firebird X 
Program folder for either Mac or Windows) as the preferred location to store SubPresets. 
(Although not recommended, you can navigate to a different folder if you prefer.)
3. Name the file, then click on Save.

To import a saved SubPresets file:

1. Go File > Import SubPresets.
2. The Editor navigates automatically to the Bin folder. If you saved the file elsewhere, you 
will need to navigate to it manually.
3. Select the desired SubPresets file.
4. Click on Open.
5. An Overwrite Warning menu appears if the SubPresets file contains saved settings that 
already exist. You can choose which saved settings to overwrite by clicking on Yes, reject 
overwriting a saved setting by clicking on No, accept all overwrites by clocking on Yes to 
All, or reject all overwrites by clicking on No to All.

Master FX Wet/DryMaster FX Wet/Dry

When set to Dry, this button is a global bypass for all effects. The Firebird X output comes 
solely from whatever pickups you have selected and there is no processing. Although you 
cannot edit any effects when set to Dry, you can select different magnetic pickup 
configurations.

Setting this to Wet restores whatever effects were enabled in the current patch.
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Signal SourceSignal Source

This is a diagnostic tool for sound design and “ringing out” playback systems. Clicking on 
the Source button lets you send any of three signal sources through the FBX effects chain.

Caution: Before selecting Noise or Sine, turn your monitoring system all the way down. 
Adjust the Signal Source level control to 0% (if it is already at 0%, change it and rotate it 
back to 0% to “reset” it), then return your monitoring system to a comfortable listening 
level and adjust the level control for the desired signal source volume.

Guitar: This is the normal setting. Neither Level nor Frequency controls have any effect.
Noise: This produces noise, which is handy for hearing how an effect processes all 
frequencies, not just those produced by the guitar. For example, sending noise through the 
effects makes it easy to hear how changing the PreFilter type affects the sound. The Level 
control is active, but Frequency is not.
Sine: Use this to generate a sine wave in the range of 50Hz to 12kHz. Both Level and 
Frequency controls are active.

You can use the Noise and Sine settings to test the response of your playback system, 
essentially turning Firebird X into a lab-quality signal generator. However, you will need to 
disable any effects manually if you want a flat response, as selecting Signal Source disables 
the Master FX Wet/Dry function.
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Chapter 9: Firebird X Sound Design Chapter 9: Firebird X Sound Design 

About Sound DesignAbout Sound Design

Firebird X’s onboard effects let you build sounds into the guitar itself—no matter where you 
go, or what kind of gig you’re playing, your sounds come with you. Furthermore, these 
effects are user-editable so you can create your own souunds. The art of editing the various 
effect parameters is called sound design, and it’s a challenging, fascinating process.

The FBX Editor presents all editable parameters in a guitarist-friendly, graphical interface. 
However, having access to all parameters gives the freedom to make both beautiful and 
terrible sounds. One of FBX’s design decisions was not to limit controls to “safe” settings. 
For example, you can boost EQ stages up to 36dB—unheard of even in most studio 
equalizers. While you’ll seldom use this much boost, for the times when it gives the sound 
you want, you’ll be glad it’s there.

A great preset is like a combination lock, with each parameter being a number of the 
combination. When you hit the right combination, the sound can be magical. Please note 
these tips about sound design:

✗ Small changes can make big differences. Changing just one parameter by a small 
amount can make a huge difference in the sound, particularly with respect to how 
EQ affects distortion.

✗ Save often! Few aspects of sound design are more frustrating than getting a great 
sound, then thinking you can do better...and you lose the “combination” by over-
tweaking.

✗ Experiment. FBX Editor gives you a world of “what ifs,” and half of the fun of FBX is 
finding out the answers to those “what if” questions.

When you first start using FBX Editor, you may find it difficult to get great sounds—but the 
more you work with the sound design, the better you’ll understand how various parameters 
interact, and the easier it will be to create the sound you hear in your head.

Multi-Level UndoMulti-Level Undo

The FBX Editor has a multi-level undo function that is invaluable for those who want to 
create their own sounds. If you made an edit and want to undo it, or made several edits 
and want to revert to how the sound was originally, keep hitting Ctrl-Z (Mac: Command-Z) 
or selecting File > Undo from the File menu until you get back to the desired state. This 
applies to all effects, as well as the Volume and Digital Varitone editing functions.
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Virtual Pickup WiringVirtual Pickup Wiring

The FBX pickup coils are completely configurable via analog switching, so you can create 
not only the kind of custom wirings that used to require a soldering iron and exotic 
switches, but pickup combinations unique to Firebird X. There are over 2,000 unique 
possible pickup wirings.

To choose a pickup wiring, click on the pickup.

✗ A pop-up menu appears with 12 options, as well as off.
✗ Each of the three pickups has identical wiring options.
✗ The currently-selected coil configuration will be outlined.

Each pickup graphic shows the polarity for individual coils (the smaller + and - signs), and 
the overall pickup polarity (the large + and – signs).

Note that as subsequent stages provide gain, you can use pickup combinations (like out-of-
phase options) that would normally provide too low a level to be useable.
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The Tone BlockThe Tone Block

The Tone Block is where you can further edit the basic pickup sound. It consists of: 

✗ 9-band parametric EQ for the sum of the magnetic pickups
✗ 9-band parametric EQ for the piezo pickup
✗ Blend control for setting the balance of the magnetic and piezo pickups
✗ Prefilter for reducing low frequencies

The Tone Block Summary Box sliders show the Magnetic EQ Gain, Piezo EQ Gain, and Piezo 
Blend settings. Its bypass button bypasses all effects within the Tone Block. Click on the 
Tone Block Summary Box to open up the Tone Block for editing.

The Tone Block Summary Box is on the left, and Tone Block effects are on the right.

To edit an effect, click on its name in the main Tone Block.

Several parameters are adjustable in the main Tone Block without having to open up an 
effect:

✗ Piezo EQ Level and Bypass
✗ Magnetic EQ Level and Bypass
✗ Piezo blend
✗ PreFilter on/off (use either the square bypass button or the footswitch)
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9-Band Magnetic EQ9-Band Magnetic EQ

The nine-stage EQ affects the magnetic pickup tone. Nine bands allows for an exceptional 
degree of control, and In conjunction with pickup selection, can re-create the tonal 
response of a huge variety of existing guitars (as well as guitars yet to be invented). The 
Magnetic EQ follows the sum of the three pickups.

The Magnetic EQ can also pre-condition the guitar sound prior to entering the distortion. 
For example, if you boost around 800Hz, then higher notes will distort more readily than 
lower ones; this can work really well for leads.

Parametric StagesParametric Stages

Each stage has the following controls (from top to bottom; the following shows two typical 
bands)

Frequency: Covers 20Hz to 20kHz
Boost/Cut: Up to ±36dB. Caution! Most studio EQs cover a range of ±12 to ±18dB—much less 
than the Firebird X EQ, which can provide truly radical settings for guitar. This flexibility 
means it’s possible to add extremely high gain settings that can lead to distortion. Be 
careful when using extreme EQ settings.
Bandwidth: Q factor from 0.70 (broad bandwidth) to 1,000 (extremely narrow)

Band 1 has an additional Shelf/Band button. Clicking on Shelf for Band 1 changes the 
response from parametric to a low-frequency shelf.

Band 9 has an additional Shelf/Band button. Clicking on Shelf for Band 9 changes the 
response from parametric to a high-frequency shelf.
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There are also Input and Output level sliders.

The following screen illustrates a variety of responses.

Band 1 is a shelf response that’s boosting the bass
Band 4 is set to a fairly wide boost at around 740Hz
Band 6 provides a deep, narrow notch at about 2.3kHz
Band 9 is a shelf response that’s reducing the high frequencies

Parametric TipsParametric Tips

✗ To adjust settings, turn the knobs or grab a point on the graph and move it. 
Moving a point horizontally changes frequency; moving vertically changes boost/cut.

✗ Each point is color-coded. When you adjust frequency either by turning a knob or 
grabbing a point, the bottom of the knob glows the associated color. 

✗ When the cursor is on the graph, two readouts appear toward the bottom of the 
graph. These are visible for as long as you’re moving the cursor, and persist for a 
couple seconds after it stops moving. The lower left readout shows the frequency as 
a note (with any offset from this pitch expressed in cents), while the lower right 
readout shows the frequency in Hz, and amplitude in dB.

✗ There are scroll bars on the right and bottom of the graph. Moving the handles on 
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the scroll bar ends toward the center shortens the scroll bar, and zooms in. 
✗ Click on a shortened scroll bar and drag to scroll within the graph.
✗ You can reset the zoom level. Click on the button at the graph’s lower right, where 

the scroll bars meet.
✗ Use level controls to compensate for radical tone changes. With settings that use a 

lot of boosting, consider turning down the Input level to allow for enough headroom 
within the EQ. Conversely, with settings that cut the signal significantly, increase the 
input to use the full available headroom.

✗ Reset All parameters. The Submenu section has a that restores all controls to their 
default positions.

9-Band Piezo EQ9-Band Piezo EQ

This EQ is functionally identical to the Magnetic EQ, but processes the Piezo pickup.

BlendBlend

This has only one control, which crossfades between the magnetic and piezo output. Adjust 
this from the Tone Block (there is no “effect” to open). 

✗ Fully counterclockwise is magnetic pickup only.
✗ Middle position is both pickups at equal levels.
✗ Fully clockwise is piezo pickup only.

PreFilterPreFilter

This highpass filter follows the mix of the magnetic and piezo sounds. It basically removes 
low frequencies, but with several variations. Here’s how the controls affect the sound.
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Frequency: Determines the frequency below which signals will be attenuated.
Type: Chooses the filter response characteristics.
 

✗ Flat acts like a traditional highpass filter, and affects only signals below the cutoff 
frequency.

✗ Low Bump adds a subtle bass boost at the cutoff frequency.
✗ Vintage 1 reduces high frequencies slightly by a fixed amount.
✗ Vintage 2 further reduces high frequencies compared to Vintage 1.
✗ Vintage 3 further reduces high frequencies compared to Vintage 2.

PreFilter TipsPreFilter Tips

Shape dry guitar sounds. The PreFilter is excellent for shaping sounds in a broad, gentle 
way without using EQ. 
Condition the sound prior to distortion. The Vintage settings, by reducing high 
frequencies, can gives a smoother, less harsh sound.
Audition the PreFilter using noise as a source. Click on the Source button to choose Noise 
as a signal source, as this sometimes makes it easier to hear the PreFilter subtleties 
compared to listening with guitar.
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The Tube BlockThe Tube Block

The Tube Block adds distortion, sustain, and gating effects. It consists of: 

✗ Noise gate
✗ Compressor
✗ Distortion
✗ Cabinet simulation

The Tube Block Summary Box shows the Noise Gate Threshold, Compressor Threshold, and 
Distortion Level. Its bypass button bypasses all effects within the Tone Block. Click on the 
Tube Block Summary Box to open up the Tube Block for editing.

The Tube Block Summary Box is on the left, and Tube Block effects are on the right.

To edit an effect, click on its name in the main Tube Block.

Several parameters are adjustable in the main Tube Block without having to open up an 
effect:

✗ Noise Gate Threshold and Bypass
✗ Compressor Threshold and Bypass
✗ Distortion Wet Level and Bypass
✗ Cabinet Bypass
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Noise GateNoise Gate

The Noise Gate mutes the input signal when it falls below a specified level, which blocks 
low-level hiss and hum from proceeeding to the output. There are four controls.

Threshold: Signals below this level are blocked (i.e., the gate is “closed”).
Attack: This sets how fast the signal unmutes after it rises above the threshold.
Hold: Keeps the gate open for the specified amount of time, even if the input signal passes 
below the threshold again.
Release: Sets how long it takes for the signal to mute after it passes below the threshold.

Noise Gate TipsNoise Gate Tips

Attack fade-in. This requires careful playing, as you need a brief silence before an attack 
can occur. Set Threshold fairly high (like -45dB), Hold to 50ms, and Release to about 100ms. 
Set Attack to around 300ms. With the guitar silent, strike a chord. When the chord level 
exceeds the threshold, it will fade in based on the Attack time.
Avoid “chatter.” If your signal crosses rapidly back and forth across the threshold, the 
noise gate can chatter as it opens and closes. Lengthening the Hold time, Release time, or 
both can prevent this.
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CompressorCompressor

The Compressor reduces dynamic range by restricting peaks and bringing up softer signals. 
This can increase sustain, and make dynamic changes less abrupt. There are six controls.

Pregain: Adds extra compression by increasing the level going into the compressor.
Threshold: Compression occurs for signals above this level.
Response: Faster settings emphasize the attack and decay equally. Slower settings 
emphasize the attack.
Ratio: Sets the extent of the compression. For example with a 2:1 ratio, an input signal 
that exceeds the threshold by 2dB produces only a 1dB increase in output level. With an 8:1 
ratio, an input signal that exceeds the threshold by 8dB produces a 1dB output increase.
Sustain: Brings up lower levels to increase the amount of sustain.
Release: Sets how long it takes for compression to release its effect after the signal passes 
below the threshold. Longer settings produce a smoother sound as the guitar string decays.

The left meter shows the compressor input, and the right level, the output.

Compressor TipsCompressor Tips

Default. Setting all sliders to their middle position is a good “point of departure” preset. 
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DistortionDistortion

This Distortion section can achieve a wide variety of sounds, from vintage to high-gain. 
However, note that distortion is highly influenced by the pickup selection, amount of 
compression, Tone Block EQ, PreFilter, and both stages of post-distortion EQ (six-band 
parametric and output 31-band graphic EQ). Even slight changes in any of these modules 
can make a major difference to the overall sound.

Drive SectionDrive Section

The drive section alters the distortion tonality through filtering. The three controls (Drive, 
Frequency, and Drive Type) interact to varying degrees.

Drive: Think of this as the “more” control for whatever filter effect you dial in with the 
Frequency and Drive Type controls.
Frequency: Sets the frequency of one of several filter types (Drive Type).
Drive Type: Each of the nine drive types has a specific character.

✗ Normal is a traditional parametric peaking response, somewhat like a mild wah. 
Varying Frequency with Drive turned down has no effect; turning up Drive 
emphasizes response at the filter frequency.

✗ Wide is similar to Normal, but the filter has a wider bandwidth that affects a wider 
band of frequencies.

✗ Low is also similar to Normal but at higher Frequency settings, more low frequencies 
remain present.
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✗ Bandpass resembles a parametric peak response, but rolls off frequencies above and 
below the center Frequency settings more drastically than a parametric. This effect 
is most pronounced with Drive at minimum. Turning up Drive brings the highs and 
lows back in.

✗ Resonant Low Pass rolls off highs starting at the chosen Frequency; turning up Drive 
increases a resonant peak at this Frequency. Even with Drive turned all the way 
down, varying Frequency affects the sound.

✗ Variable Q Low Pass is a variation on the Resonant Low Pass, where the resonance 
decreases at lower Frequency settings. Even with Drive turned all the way down, 
varying Frequency affects the sound.

✗ Resonant High Pass rolls off lows starting at the chosen Frequency; turning up Drive 
increases a resonant peak at this Frequency. Varying Frequency has an effect even 
with Drive turned all the way down.

✗ Variable Q High Pass is a variation on the Resonant High Pass, where the resonance 
decreases at lower Frequency settings. Varying Frequency has an effect even with 
Drive turned all the way down.

✗ Tight Q is similar to Normal, with a much sharper resonant peak. Varying Frequency 
with Drive turned down has no effect,while turning up Drive increases the resonant 
peak’s level.

Distortion TypeDistortion Type

This chooses one of ten distortion algorithms. The first six (Light, Light II, Medium, Heavy, 
Shred, and Screamer) increase the amount of distortion and high-frequency content from 
Light to Screamer.

Overdrive is a different distortion algorithm. The Postfilter, which trims highs and is 
optional for the other distortion types, is always enabled with Overdrive.

The three saturation options have more high-frequency content than the first six types.

PostfilterPostfilter

Typical guitar amp/cabinet combinations have an abrupt high-frequency rolloff, with little 
energy above 6kHz. This natural filtering effect creates a smoother sound; many guitarists 
are surprised when they hear tube distortion by itself, with no cabinet, as the sound can 
have a spiky, jagged quality. The FBX distortion section is faithful to tube characteristics, so 
to obtain a convincing amp sound, it’s necessary to shape the sound with EQ.

The Postfilter is one of four post-distortion EQ elements (the other three are the Cabinet, 
post-distortion EQ, and 31-band graphic EQ). This may seem excessive, but real-world 
cabinets have very uneven responses that can’t be emulated without sophisticated EQ.

Page 39



The Postfilter provides “brute force” filtering and with many distortion sounds, will be all 
you need. As mentioned, it’s always enabled for the Overdrive algorithm. However, 
supplementing or replacing it with the other filters can be equally effective. 

Distortion Waveform ControlsDistortion Waveform Controls

These controls further modify the distortion’s character.

Amount: This controls the amount of distortion gain, which increases the distortion’s 
intensity.
DC offset: Moving this slider upward creates more asymmetrical distortion, where one half 
of the waveform is distorted more than the other. This creates a subtle change that adds 
more high-frequency components to the guitar, and Is especially noticeable with single 
notes. 

Level ControlsLevel Controls

Unlike most distortions, there are two options for level control.

Output: This controls the distortion section’s final output level.
Wet Level: At 0%, the output consists of only the dry signal coming in to the distortion. 
Moving the slider up toward 100% acts like a balance control, with the dry signal decreasing 
and the distorted signal increasing. At 100%, the output is 100% distortion signal. 
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CabinetCabinet

The cabinet section offers 8 cabinet types and two direct types (Direct is flat, Direct+ has a 
low cut filter at 30Hz). There are also three EQ stages for further tone shaping: low shelf 
(Band 1), parametric (Band 2), and high shelf (Band 3).

Note that a six-band EQ (described next) follows the Cabinet. For most patches, the 
Cabinet is intended to provide general tone-shaping, while the six-band EQ can add more 
“surgical” EQ for precise tonal changes. 

Cabinet TipsCabinet Tips

Amp cabinet tweaking. One of the main differences among different amps is where the 
response peaks in the midrange. For example, one popular “citrus” amp has a fairly 
pronounced peak around 3-4kHz. The Band 2 control is useful for adding peaks or dips to 
the basic cabinet type. 
Amp placement. Placing an amp in a corner, raised on a chair or riser, or with its back 
against the wall all affect the bass response. The Band 1 control can emulate these effects. 
As one example, if an open back amp doesn’t sound quite thin enough, reduce the bass to 
give a more pronounced open back sound. This can also help prevent “fighting” with the 
bass frequency range.
Increasing presence. It’s common to reduce the highs going into distortion to create a 
smoother distortion sound—distorting harmonics can sound harsh, which is why many 
guitarists roll back their tone control prior to feeding distortion. However, this can also 
result in a duller distortion sound. Boosting with Band 3 can increase the brightness and 
presence of distortion-based sounds.
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EQ (Six-Band)EQ (Six-Band)

This post-distortion EQ is a single effect. Its block exposes the output level control and 
enable/bypass switch. 

This EQ is ideal for additional tone shaping for the distortion and cabinet. It’s identical to 
the nine-band Magnetic EQ and Piezo EQ with the following exceptions:

✗ There are four parametric stages instead of seven. As with the 9-band EQs, the 
lowest and highest bands can provide parametric or shelving functions.

✗ There are no input and output meters on the module itself. 

Note that a six-band EQ follows the Cabinet (described previously). For most patches, use 
the Cabinet for general tone-shaping, and the six-band EQ to create more “detailed” 
responses. 
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OctaverOctaver

This Octaver is a single effect that provides two parallel harmonies—one octave below and 
two octaves below the input note. Its block exposes the output level control and the 
enable/bypass switch. 

The Octave 1 control determines the octave-below level, while Octave 2 sets the two-
octave-below level.

Octaver TipsOctaver Tips

Single notes only. The Octaver is intended to work only with single note lines, not chords.
Minimize harmonics for best tracking. If the Octaver receives a harmonic that’s stronger 
than the fundamental, it will try to process that note instead, and “jump” between the 
fundamental and harmonic. For the best tracking, use the neck pickup with the Single Coil 
Neck position pickup.
Signal chain position. The Octaver receives its signal from after the compressor, bypasses 
the distortion section, then mixes into the Modulation block input. As a result, distortion 
settings do not affect the Octaver, whose signal is in parallel with the distortion.
Compression can give a smoother response. Enabling compression can often improve 
tracking by providing a more consistent signal.
Avoid the open low E and A strings. These produce lots of harmonics, and are difficult to 
track. Best tracking occurs between low F up to one octave above the high E string, 
excluding the open A string.
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WahWah

This Wah is a single effect that is essentially a bandpass filter. Although it’s intended to be 
used with the pedal, you can also use it as a filter effect. Its block exposes the 
enable/bypass switch. 

Frequency: Sets the bandpass filter’s center frequency. The pedal controls this parameter.
Filter Gain: This parameter, directly below the Frequency control, determines the boost 
amount at the selected frequency.
Q: This is the lower parameter in the Wah module, and sets the range of frequencies that 
are boosted, centered around the main frequency. Lower Q values boost a wider range, 
while higher Q values boost a narrower range.
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The Tape Effects BlockThe Tape Effects Block

The Tape Effects Block includes a variety of modulation, delay, and reverb effects: 

✗ Chorus/flanger/vibrato/Automatic Double Tracking (ADT)/resonator
✗ Phaser
✗ Tremolo
✗ Delay 1 (with chorus, ducking, and reverse delay)
✗ Delay 2 (with chorus and ducking)
✗ Reverb

The Tube Block Summary Box shows the Phaser and Tremolo Depth, and wet levels for 
Chorus, Delay 1, Delay 2, and Reverb. Its bypass button bypasses all Tone Block effects. 
Click on the Tube Block Summary Box to open up the Tape Effects Block for editing.

The Tape Effects Summary Box (right) and Tape Effects Block processors (left).

To edit an effect, click on its name in the main Tape Effects Block.

Several parameters are adjustable in the main Tube Block without having to open up an 
effect:

✗ Enable/bypass buttons for all effects (use the button or footswitch)
✗ Phaser and Tremolo Depth controls
✗ Chorus, Delay 1, Delay 2, and Reverb Wet Level controls.
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ChorusChorus

The Chorus creates the sound of two guitars playing together, but can also produce 
flanging, ADT (Automatic Double Tracking), vibrato, and resonator effects. These controls 
often interact; for example, if you increase Rate or Delay, you may need to decrease 
Depth. The end of this section goes into detail on how to create these various effects.

Delay: Sets the fundamental range covered by the effect. Shorter delays are for flanging, 
vibrato, and resonators, while longer delays work for chorusing and ADT.
Rate: Determines the modulation effect’s speed, or rate of change.
Depth: Edits the extent to which modulation influences the effect.
Feedback: Recirculates some of the effect’s output back to input to increase resonance.
Wet Level: Adjusts the percentage of the processed signal in the overall output.
Type: Selects among Chorus/Flanger and Vibrato. The Chorus/Flanger setting also provides 
ADT, while the Vibrato can provide resonator effects.

As the functions of the various controls vary depending on the type of effect you want to 
create, we’ll proceed to tips on obtaining these effects.
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Chorus TipsChorus Tips

The following screen shot shows settings for a typical chorus sound.

Type. Set to Chorus/Flanging.
Delay. Most chorusing happens in the 5 to 25ms range. Shorter delays tend more toward 
flanging, while longer settings tend more toward Automatic Double Tracking and delay.
Rate. Chorusing uses slow rates for rolling, majestic sounds, while higher speeds produce 
an effect that’s more like a fast rotating speaker.
Depth. The optimum depth depends on the Delay and Rate settings. The longer the Delay 
and/or the faster the Rate, the more you’ll need to reduce Depth to avoid an excessive 
amount of pitch change (unless, of course, you’re into excessive effects).
Feedback. Chorusing usually doesn’t add much feedback, as less feedback gives a “gentler” 
sound. 0 to 25% is common.
Wet Level. Chorusing is most pronounced when the dry and delayed signals are the same 
level (i.e., Wet Level set to 100%). For more subtle chorusing, reduce the Wet Level.

Some chorus effects include more than one delayed sound to offer “multi-voice” chorusing, 
which sounds like more than two instruments playing together. Although the Chorus module 
is not multi-voice, both Delay 1 and Delay 2 can provide chorusing effects, which gives the 
equivalent of three-voice chorusing. See the section on Delay Tips for information on how 
to create chorusing effects with the Delays.
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Flanging TipsFlanging Tips

The following screen shot shows settings for a typical flanger sound.

Type. Set to Chorus/Flanging.
Delay. Shorter delays cover the range associated with flanging. Delays longer than 5ms or 
soget into the chorusing and delay ranges.
Rate. Rates for flanging are relatively slow so that the effect is more obvious.
Depth. For the widest flanging range, set this to slightly less than the Delay value. Note 
that it’s not possible to set a Depth greater than the Delay value.
Feedback. Increasing feedback gives a sharper, more resonant effect. Settings around 60-
70% are common for dramatic effects.
Wet Level. Flanging is most pronounced when the dry and delayed signals are the same 
level (i.e., Wet Level set to 100%). With high feedback settings, try bringing this down 10-
20% to even out the levels more.
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Automatic Double Tracking TipsAutomatic Double Tracking Tips

Automatic Double Tracking simulates the effect of playing along with a part to double it. 
Because a musician won’t be able to duplicate the part exactly, there will be slight, 
variable timing differences that the Chorus can provide. The following screen shot shows 
settings for a typical ADT sound.

Type. Set to Chorus/Flanging.
Delay. This sets the basic offset of the “doubled” part. Longer delays make the doubling 
more obvious.
Rate. A very slow rate prevents obvious chorusing effects, but provides some variation in 
the delay between the original and “doubled” note.
Depth. This determines the delay time variation (altered slightly by the Rate control) 
between the straight and doubled sounds. Higher depth settings produce a “looser” 
doubling, while lower depth settings give a “tighter” doubling effect.
Feedback. This should be set to 0 as the object is to double the dry sound, and Feedback 
creates multiple repeats.
Wet Level. You’ll usually want to emphasize the dry sound, with the doubled sound 
providing support. Reducing Wet Level to about 80% does this, but you can set it to 100% if 
you want to give equal “weight” to the doubled line.
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Vibrato TipsVibrato Tips

Vibrato creates a periodic pitch change and should not be confused with Tremolo (covered 
later), which creates a periodic level (amplitude) change. (Part of the reason for this 
confusion is that a certain amp manufacturer incorrectly refers to tremolo as vibrato.) The 
screen shot shows settings for a typical vibrato effect.

Type. Set to Vibrato.
Delay. You don’t need long delays to create vibrato, so a short setting (around 1.5 to 2ms) 
minimizes any delay through the module.
Rate. Vocal vibrato rates generally fall in the range of 4 to 7Hz, so most vibratos follow this 
precedent. Of course, feel free to try faster and slower settings.
Depth. To avoid an “out of tune” sound, this needs to be pretty low.
Feedback. For the most realistic vibrato sound, set this to 0.
Wet Level. 100% gives the most natural vibrato effect.

Here are two other vibrato-based effects.

✗ For a “wah meets fast rotating speaker” effects, use the same settings shown above 
for vibrato, but increase Feedback to 60%.

✗ For a more “shimmering” vibrato, use the same settings shown above for vibrato, but 
increase Feedback to 40% and decrease Wet Level to 50%.
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Resonator TipsResonator Tips

A resonator adds feedback at one specific frequency, which often generates response peaks 
at multiple harmonics of that frequency. There are several ways to obtain resonator effects 
with Firebird X; the screen shot shows settings for a typical resonator sound using the 
Vibrato effect.

Type. Set to Vibrato.
Delay. This sets the resonant frequency. [1/(time in seconds)] gives the note frequency in 
Hz (in this case, 1/0.0022 = 440 so the resonator is resonating at A 440Hz). Remember, you 
can click on the Delay field and type in a precise setting. Note: It takes a while for the 
Delay time to “settle” after adjusting it.
Rate. As you don’t want the resonant frequency to change, set this to minimum.
Depth. Also set this to minimum to avoid changing the resonant frequency.
Feedback. The determines the amount of resonance. Settings much above 80% can give 
excessively loud signals when a note hits the resonant frequency—be careful.
Wet Level. This has no effect when Vibrato is serving as a resonator.

Alternate flanging sound: For a resonant flanging effect, use the above settings but set the 
Depth at slightly less than the Delay (e.g., if Delay is 2.20ms, then set Depth to 2.00ms). 
This provides an alternative sound to the standard Firebird X flanging effect.
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PhaserPhaser

The Phaser effect was very popular in the late 60s and 70s, and produces a resonant, thick, 
“underwater” modulating effect. The screen shot shows settings for a typical Phaser sound.

Minimum: Sets the phaser sweep’s lowest frequency limit. 
Maximum: Sets the phaser sweep’s highest frequency limit.
Rate: Determines the speed at which the phaser sweeps between the high and low limits.
Depth: This is more similar to a “wet/dry” control where increasing the Depth makes the 
phaser effect more apparent.
Feedback: Recirculates some of the output back to the input to increase the “sharpness” 
and resonance of the phasing effect.
Type: Selects among two different modulation waveforms. Sine produces more of a “pulse” 
between the high and low limits, whereas Triangle provides a smoother, sweeping effect.

Phaser TipsPhaser Tips

The Phaser can also create static resonator effects with a very different character from 
Vibrato- or Delay-based resonators. To adjust the resonant frequency:

1. Set Minimum to the desired resonant frequency (it cannot be higher than the Maximum 
setting).
2. Bring Maximum down to the same setting as Minimum.
3. Adjust Depth and Feedback for the desired tonality.

Rate and Type have no influence with Minimum and Maximum set to the same value.
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TremoloTremolo

Tremolo causes a periodic change in level. The screen shot shows settings for a typical 
Tremolo effect.

Rate: Sets the speed of the Tremolo effect as it varies between the highest and lowest 
level. 
Depth: Determines the difference between the highest and lowest levels. At 0%, the level is 
always at maximum. Increasing toward 100% sets a progressively lower minimum level for 
the tremolo sweep. 100% depth alternates the tremolo level between full on and full off.
Chorus/LFO Sync button: This syncs the Tremolo to the Chorus so that the Chorus Rate 
control determines the rate for both effects. Use this option when designing rotating 
speaker effects, as a rotating speaker causes both time delay and amplitude changes.
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Delay 1Delay 1

Firebird X’s Delay is an unusually flexible variation on standard delays, with many 
additional features. There are four main modes: Standard Delay (with Looping), Chorus 
Delay, Ducking Delay, and Reverse Delay. As with the Chorus, we’ll cover each option in its 
own Tips section.

Standard Delay TipsStandard Delay Tips

The screen shot shows the controls you’d use for standard Delay effects.

Time: Edits the Delay time, from 0 milliseconds to 10 seconds. Longer times are ideal for 
looping. 
Feedback: Recirculates the output back to the input to create multiple, decaying echoes.
Lowpass Enable: Turns the feedback path Low pass filter on or off (see next).
Low Pass: Sets the frequency of a low pass filter inserted in the feedback path. With 
filtering, subsequent echoes have successively less high-frequency response compared to 
the original signal. This has two main uses: Filtering prevents echoes (which have less 
presence) from “stepping on” the original part, and can also help emulate vintage echo 
units and tape echo units, which had reduced high frequency response compared to today’s 
digital delays.
Wet Level: At 0%, there is no Delay signal present in the output. Increasing the percentage 
increases the blend of Delayed signal in the output.
Type: Forward produces standard delay effects.
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Chorus/Delay TipsChorus/Delay Tips

The screen shot shows the additional controls that you’d use in addition to the standard 
Delay controls shown above to provide Chorus/Delay effects.

 

Mod Rate: Determines the chorusing effect’s speed.
Mod Depth: Sets the chorusing effect’s intensity. 

The longer the delay time, the more effect modulation has on the signal. The chorus effect 
occurs from modulating the delayed signal, which causes timing differences between 
subsequent echoes as well as the main, dry signal if it’s at the same pitch.

To emulate older analog chorus/delay effects, enable the Low pass filter and set it to 
around 6-7kHz.
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Ducking Delay TipsDucking Delay Tips

“Ducking” delay mutes or attenuates the delayed echoes while you play, but when you stop 
playing, they become audible. The screen shot shows the additional controls that you’d use 
in addition to the standard Delay controls (shown earlier) to provide Ducking Delay effects.

Ducking: Sets how much echoes are attenuated when you’re playing. Higher numbers mean 
more attenuation.
Sensitivity: Determines the level of your playing where ducking begins. At 0%, no matter 
how hard you play, ducking will not occur. At higher percentages, ducking occurs at lower 
levels of your playing. With 100% sensitivity, even if you play very softly the echoes will be 
ducked while you play.
Release: After you stop playing, this sets how long it takes for the ducked sound to ramp up 
from attenuated to non-attenuated levels. 
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Reverse Delay TipsReverse Delay Tips

Reverse delay produces the “backwards tape” sounds popularized in the 1960s. It works by 
storing what you play for the length of the delay time, then playing it back in reverse. The 
screen shot shows the only controls that apply to reverse delay. 

Time: Sets the amount of time for which sound is recorded before it plays back. For 
example, with a delay time of 1 second, after 1 second what’s recorded plays back in 
reverse. This recording is continuous, so whatever you play will play back 1 second later, 
but in reverse.
Feedback: Like standard delay, this creates additional echoes (but of the reversed sound).
Wet Level: Determines the proportion of reverse delay with the dry, original signal. Set this 
to 100% to hear reversed/delayed sound only.
Type: Set this to Reverse.
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Delay 2Delay 2

Delay 2 is identical to Delay 1, except that it doesn’t have the reverse delay feature.
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Reverb Reverb 

The Firebird X reverb is more like a “reverb construction kit.” You can construct spring 
reverbs, halls, room ambiences, and more. Furthermore, it allows for ducking reverb and 
gated reverb.

The Reverb has two windows. The primary one (the upper window in the screen shot) has 
the main reverb controls. The Diffusers window (the lower window in the screen shot) is 
where you construct your actual acoustical space.
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Ducking Reverb TipsDucking Reverb Tips

“Ducking” reverb mutes or attenuates the reverb while you play, but when you stop 
playing, it becomes audible. The controls work very similarly to Ducking Delay, as described 
previously.

Ducking: Sets how much the reverb is attenuated when you’re playing. Higher numbers 
mean more attenuation.
Sensitivity: Determines the level of your playing where ducking begins. At 0%, no matter 
how hard you play, ducking will not occur. At higher percentages, ducking occurs at lower 
levels of your playing. With 100% sensitivity, even if you play very softly the reverb will be 
ducked while you play.
Release: After you stop playing, this sets how long it takes for the reverb tail to ramp up 
from attenuated to non-attenuated levels. 

Gating Reverb TipsGating Reverb Tips

“Gating” reverb is the opposite of Ducking reverb—reverb is present when you’re playing 
(gate “open”), but when the input sound drops below a certain level, the gate “closes” and 
mutes the reverb.

Gating: Sets the amount of reverb attenuation when the gate closes. Higher numbers mean 
more attenuation.
Sensitivity: Determines the level where the gate opens and you hear reverb. At 0%, no 
matter how hard you play, you won’t hear reverb. At higher percentages, you’ll hear reverb 
at lower levels of your playing. With 100% sensitivity, even if you play very softly, or the 
note is well into its decay, you’ll hear reverb.
Release: When you gate closes, this determines how long it takes for the reverb to decay to 
the amount of attenuation set by the Gating slider.

Diffusers TipsDiffusers Tips

Reverb results from sound waves bouncing off of surfaces in an acoustic space. There are 
multiple echoes as the waves off the walls, ceilings, hard surfaces like tables, and so on. 
However, they also lose a little energy with each bounce, thus reducing the level. If the 
waves bounce off soft or absorptive surfaces, they lose high frequencies as well.

The diffusers section provides eight delay lines to simulate the sound of the multiple 
echoes that occur in an acoustic space. The delay times are restricted to prime numbers so 
that the echoes don’t follow a “rhythm,” thus giving a more realistic, randomized sound.

Each delay tap has the same controls. 
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Frequency: This is like the Low pass filter in the Delay effects, as it’s inserted in the delay 
line’s feedback loop. The effect this produces is commonly called “damping.” Reducing the 
frequency emulates the effect of waves bouncing around in a room with absorptive 
surfaces; turning the Frequency down to 20Hz essentially disables the tap.
Delay time: This sets the tap’s delay. Note that Firebird X has a finite amount of memory 
dedicated to the reverb, and longer delays use up more memory. When you vary a Delay 
Time control, a “Tank” readout appears at the bottom of the diffusers window that 
indicates how much of the available memory has been used. If turning up a delay 
parameter causes the reverb to run out of memory, the Tank readout shows 100%, the 
parameter briefly flashes red, and is re-adjusted to the highest allowable delay.
Feedback: Determines the number of echo repeats, just like the Feedback control in the 
Delay effect.
Enable/Bypass button: This turns Feedback on or off for the selected tap.

There’s also a global control that affects all taps, as follows.

Link Feedback Knobs: When checked, adjusting one Feedback control adjusts all the other 
Feedback controls simultaneously. This is equivalent to changing the reverb time, as higher 
Feedback values give longer reverb times.

Note that if there’s an offset between Feedback values when you enable linking, that offset 
will be preserved as you adjust the knobs until a knob reaches a maximum or minimum 
value. At that point a value cannot go any further. This also means you can quickly set all 
Feedback knobs to the same value by linking the controls, then moving one control all the 
way up and all the way down.

For realistic acoustical spaces, set the Delay Times to fairly similar values as long as they’re 
all different. The longer the delays, the bigger the space. For more “periodic” delay 
sounds, like spring reverb, use fewer taps and fairly short delay times. Experiment!
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Graphic EQGraphic EQ

This final processor in the signal chain is a 31-band (one-third octave) graphic EQ. This is a 
single effect whose block exposes the output level control and enable/bypass switch. 

In addition to Input and Output level controls, each band has a dot that you can drag up or 
down, with plus or minus 36dB of gain per band.

The Graphic EQ has several applications.

✗ Create highly accurate speaker cabinet emulations. You can actually draw in a 
cabinet’s frequency response if you have the data available.

✗ Match FBX to a particular venue. For example, suppose you play an auditorium with 
a lot of absorptive surfaces that dulls the sound, and a club with hard walls and a 
low ceiling that brightens the sound. You can come up with compensating Graphic EQ 
curves for each one, save them as settings, and call up the appropriate curve for the 
appropriate venue.

✗ Final tone-shaping for the signal chain. If you still haven’t gotten the tone you 
want by the time you get here (which is probably doubtful!), here’s yet another 
option to tweak the tone in an extremely detailed manner.

✗ Compensating for going through different amps, or going direct. You can create 
curves that match different amps, compensate for response differences, or emulate 
particular cabinets when doing direct. If you then go through an amp, simply disable 
the EQ.
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